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Welcome

Avenza welcomes you to mapmaking in the 21st century!

Combined with Adobe Illustrator, MAPublisher has revolutionized the art of mapmaking by allowing spatial data
files to be used to create maps inside a vector graphics program. MAPublisher allows all your cartographic tasks to
be performed where they should be done; in a powerful graphics environment.

MAPublisher LabelPro™ revolutionizes the way users can label map data, including using symbols as labels, conflict
resolution, and highly configurable rule-based labeling options. The MAP LabelPro engine uses map data attributes
for labeling with styles, rules and controls configured through an intuitive, easy-to-use Graphical User Interface.

This tutorial assumes that the user is familiar with Adobe Illustrator CS5/CS5.1/CS6, and has at least a basic
understanding of MAPublisher tools and features. Not all MAPublisher tools are explained in this document. This
tutorial should be used in conjunction with the MAPublisher 9.1 User Guide, MAPublisher 9.1 Tutorial Guide and
Quick Start Guide for an understanding of all the other MAPublisher tools.

By following this tutorial, you will learn how to setup and use the MAP LabelPro labeling engine to label your

map created in MAPublisher. Working on a provided map, users learn to create rules and styles for labeling in an
automated and efficient way.

MAP LabelPro Tutorial Data

This tutorial will use Adobe lllustrator files and MAP LabelPro rules installed with MAPublisher 9.1. You can find the
MAP LabelPro Tutorial data in the following location on your hard drive:

Windows XP
C:\Documents and Settings\All Users\Shared Documents\Avenza\MAPublisher 9\MAP LabelPro Tutorial & Data\Data

Windows Vista and Windows 7
C:\Users\Public\Public Documents\Avenza\MAPublisher 9\MAP LabelPro Tutorial & Data\Data

Note: This data may be accessed through shortcuts available in the Windows start menu

Mac0SX
/Applications/Avenza/MAPublisher 9.1/MAPublisher Tutorials/MAP LabelPro Tutorial & Data/Data

You are encouraged to experiment with your own data to gain additional experience with MAPublisher tools.

Tutorial data courtesy of City and County of San Francisco (San Francisco Enterprise GIS program SFGIS).

MAPublisher 9.1 LabelPro Tutorial il
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1.1 Purpose

1 Preliminaries

The purpose of this exercise is to use MAP LabelPro to create labels for a simple map of downtown San Francisco,
California, USA. For this exercise, Avenza has prepared the necessary map file created with MAPublisher 9.1 and
Adobe lllustrator, based on City and County of San Francisco GIS data (San Francisco Enterprise GIS program SFGIS).
The map contains all the different type of features (point, line and area) for labeling and/or obstacle purpose.

In this exercise, you will start by preparing the file and examining the data to familiarize yourself with the
prerequisites to using MAP LabelPro. Then, the labeling will be done in two steps: a main labeling session (labeling
public schools, streets, interstates, highways and land areas in one run) and a secondary session (labeling parks
only, using the other labels as obstacles). Although the presented settings are valid only for the map data they are
based on, the principles are applicable for your own designs.

1.2 Know your data

The MAP LabelPro Tutorial data folder contains a ready-to-use Adobe lllustrator template file containing a map of
downtown San Francisco (MAPLabelPro_Tutorial.ait). Here is a description of the layers present in the file and how
they will be used during the labeling process.

1.2.1 San Francisco map description

Layer name Type Description Labeling Attribute Obstacle?
(label source |ayers) Session #1 | Session #2
Text layers
LAND_labels Text Land labels - - No
SCHOOL_labels Text School labels - - Yes
STREET _labels Text Street labels - - Yes
PARK_labels Text Park labels - - -
HIGHWAY_INTERSTATE_labels | Text Labels for highways and interstates | - - Yes
SUPPRESSED_labels Text Labels that couldn't be placed - - No
based on the specified rules.
MAP_TITLE Text Map title (San Francisco) - Yes No
MAP Layers
Public_Schools_point Point Public school locations SCHOOL_NAME Yes Yes
Post_Offices_point Point Post office locations - Yes Yes
Highways_line Line Highway roads HIGHWAY_NUMBER Yes Yes
Interstates_line Line Interstate roads INTERSTATE_NUMBER | Yes Yes
Ramp_line Line Ramps to highways - No No
Streets_line Line San Francisco street network STREETNAME No No
Land_area Area Land areas AREA_NAME No No
Parks_area Area Park areas PARK_NAME Yes No

MAPublisher 9.1 LabelPro Tutorial
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Layer name Type Description Labeling Attribute Obstacle?
(label source |ayers) Session #1 | Session #2

Other Layers
Scale_Bar Legend | Scale bar - -
background Area Blue background to represent | - -

the sea

All map layers were imported from City and County of San Francisco GIS data (San Francisco Enterprise GIS program
SFGIS) in ESRI shapefile format and cropped to the area of interest. The map design (symbols and line styles) was
created by Avenza Systems.

1.2.2 Styles and rules

MAPublisher is installed with predefined styles and rules to use for the MAP LabelPro settings in this tutorial. These
configuration files are saved to one of three folders depending on the data type layer, | &| Area, || Line or | I’ | Point,
they are associated with.

Layer Name Type Style Rule

\LabelPro\Styles \LabelPro\Rules
Public_Schools_point Point School_Label_Style School_Label_Rule
Interstates_line Line Interstate_Label_Style Interstate_Label_Rule
Highways_line Line Highway_Label_Style Highway_Label_Rule
Streets_line Line Street_Label Style Street_Label Rule
Parks_area Area - -
Land_area Area Land_Label_Style Land_Label_Rule

The style and rules for the Parks_area layer will be created during the second labeling session of this exercise.
The default location of the Rules and Styles folders is:

Windows XP: C:\Documents and Settings\All Users\Application Data\Avenza\MAPublisher 9\LabelPro\Rules
Windows Vista: C:\ProgramData\Avenza\MAPublisher 9\LabelPro\Rules
Mac OS X: Applications/Avenza/MAPublisher 9.1/MAPublisher Plug-In/LabelPro/Rules

Note: The MAP LabelPro tutorial data folder also contains a backup for these rules and styles

1.2.3 Important note for MAPublisher LabelPro evaluation users

The evaluation version of MAPublisher LabelPro scrambles the text of placed labels but preserves the case,
spacing and punctuation so that it simulates how actual labels would be placed. Therefore, evaluation users will
experience a different result with the MAP LabelPro settings of this tutorial than licensed users. The results will be
shown and differences explained at the end of this guide. In evaluation mode, the scrambling process noticeably
slows the speed of labeling.

é MAPublisher 9.1 LabelPro Tutorial
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2 Getting Started

2.1 Open tutorial document

1. Inthe Adobe Illustrator main menu, choose File> Open and open the template file MAPLabelPro_Tutorial.ait located

in \MAPublisher 9\MAP LabelPro Tutorial Guide & Data\Data.

Al Fie Bt Chect Type S B Vs Wedow Hep W B y[=]o] x
|gemsee @DM?E NYhE D=V E08n
(e == -
— —
& L, -
o @ a
2T
/.|, =
P ¥
e & -
o, 48
i =
5.0, = £
b [ ©
B - =
. ) !. L. ~
B, (L
&=, : g £|_
? £ (CSE *
L1
e o &
I+ BN s
e CEr
L

An artboard containing a map of San Francisco opens. All the data information to be used for labeling is present,
except for the text labels. Please see the table in the Preliminaries chapter for the description of the layers.

2. Because the file was opened from a template, a new untitled document was created. Choose from the Adobe
lllustrator main menu File > Save As to save the file as San Francisco.ai.

Note: Customize the Adobe lllustrator workspace to make it easier to access panels. It may look different than
the image above. Read Customizing the workspace in the Adobe lllustrator help guide for more information.
Review also MAPublisher Preferences in the MAPublisher 9.1 User Guide.

2.2 Examine MAP Attributes available for labeling

MAP LabelPro extracts label data from the attribute table for each MAP Layer to be labeled. Therefore, it is good
practice and often required to examine or edit attribute information using the MAP Attributes panel. Edits can
include: creating a new column to enter attribute values, joining tables to import additional attribute information
from an external file, correcting spelling, changing the case of text and more.

For this exercise, all attributes are ready to use for labeling. Follow the steps here to examine them and familiarize
yourself with the data.

Note: For more information on the MAP Attributes panel, please refer to the MAPublisher 9.1 User Guide, chapter 5.

For more exercises, please see the MAPublisher Quick Start Guide and MAPublisher Tutorial Guide.

MAPublisher 9.1 LabelPro Tutorial
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1. Inthe Adobe Illustrator Layers panel, click the target button & next to the Public_Schools_point layer to select
all artwork on the layer.

2. Open the MAP Attributes panel (from the Adobe Illustrator main menu, choose Window > MAPublisher> MAP
Attributes or click the MAP Attributes button on the MAPublisher toolbar [E]).

The Public_Schools_point layer contains four visible attribute columns: OBJECTID, FACILITY_l, DEPTNAME and
SCHOOL_NAME. The SCHOOL_NAME attribute column will be used for labeling the school points.

MAP Attributes

Layer: ‘ Public_Schools_paint {24 points selected) | - ‘ -
[1]OBIECTID [E]FACILITY_I [5]DEPTNAME [5]5CHOOL_NAME

1 1,913 0000003094 SF Unified School District (SFUSD) | FRANCISCO MIDDLE SCHOOL

2 1,914 0000003095 SF Unified School District (SFUSD) | YICK WOOQ SCHOOL

3 1,915 0000003096 SF Unified School District (SFUSD) | GARFIELD SCHOOL

E 1,919 0000003102 SF Unified School District (SFUSD) | JEAM PARKER SCHOOL

5 1,920 0000003104 SF Unified School District (SFUSD) | SPRING VALLEY SCHOOL

6 1,922 | 0000003106 SF Unified School District (SFUSD) | CHINESE EDUCATION CENTER

23points seected 5 i DO /0BT

3. Selectall artwork on the Interstates_Line layer and view the attributes in the MAP Attributes panel.

MAF Attributes

Layer: ‘ Interstates_line (4 lines selected) |. ‘ o
[S|STREETNAME | [T]INTERSTATE_NUMBER

1| VAN NESS AVE 101

2| VAN NESS AVE 101

3| LOMBARD ST 10

4|LOMBARD 5T 10

4lines selected EEH Six) BE

The INTERSTATE_NUMBER attribute column will be used for labeling these roads.

Note: Notice that the INTERSTATE_NUMBER attribute is of type integer [Il. All types of attributes may be used for
labeling with MAP LabelPro.

4. Select all on the Highways_line layer and view the attributes in the MAP Attributes panel. HIGHWAY_NUMBER
will be used for labeling. View the attributes of the remaining layers: Streets_line, Parks_area, and Land_area.

Refer to the San Francisco description table in section 1.2.1 to see the attributes that will be used for labeling.
5. Close the MAP Attributes panel after reviewing it.

Knowing this information, we are ready to use the MAP LabelPro function to generate map labels for the San
Francisco downtown map.

8 MAPublisher 9.1 LabelPro Tutorial
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3 Labeling Session #1

In this first labeling session, multiple layers will be labeled in a single run of the MAP LabelPro function. The
objectives for this session are to:

Add labels for school as a first priority (source layer Public_Schools_point).

Label the interstate roads with interstate shield symbols containing the interstate number (source layer
Interstates_line).

Label the highway roads with highway shield symbols containing the highway number (source layer
Highways_line).

Add street names (source layer Streets_line).

Add names for land areas, written in the sea to make the map more readable (source layer Land_area).
Make sure that the school and road names do not overlap with the post office and school symbols and park
area, and do not cross highways and interstates line (obstacle layers: Post_Offices_point, Public_Schools_
point, Parks_area, Interstates_line and Highways_line).

To start the MAP LabelPro Editor, click the MAP LabelPro button on the MAPublisher Toolbar.

Dats Crastion Thamasic Took Lagand Tosls

tmpart/aport Pragars Gacproceming Orgasizaten Labals
HEEERT IO0OF E OYyed v/ HOeor BAY CoB% WDH <o Ao

MAP LabelPro
The MAP LabelPro dialog box opens.
MAP LabelPro
]| source %4t
¥
Advanced...
1 B
[Custon] -

Click + Setup Layers or Rules: [Custom]
Import Settings to begin

Suppression layer:

Label fiters: |,

All layers have to be configured before labeling with MAP LabelPro. The general MAP LabelPro workflow: setup
layers, specify attribute label source, set label output layer and suppression layers, set label priority, and define layer
styles and rules.

Note:

If the dialog box needs to be closed before all settings are done, make sure to click the Save button.

MAPublisher 9.1 LabelPro Tutorial 9
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3.1 Layers and obstacles setup

1.
2.

MAP_TITLE
Post_Offices_point
Public_Schools_point
Highways_line

In the MAP LabelPro editor dialog box, click the Setup Layers button.
In the Setup Layers dialog box, click the check box in the Show column for each of the following layers:

Setup Layers
MName OK
- 0 San Francisco Downtown
Cancel

HIGHWAY_INTERSTATE labels
LAND._labels

MAP_TITLE

PARK_labels

SCHOOL _labels

STREET labels

SUPPRESSED labels
Post_Offices_point
Public_Schools_point

EEEOEEE0E §

- Interstates_line
« Streets_line

P

P

Highways line

- Land_area ] Interstates_line
N Ramp_line
- Parks_area ] Streets_line

background
Land_area
[E Parks_area

]
]

3. Make sure that the settings match the image above and click OK.

The MAP LabelPro dialog box displays the MAP View and chosen layers. Layers can be designated for labeling
and obstacles in the list by clicking the appropriate column.

MAP LabelPro
< S
=] [source ®& 1
s
- @ San Francisco Downtown e
MAP_TITLE
¥ Post_Offices_point Is labeled
¥'| Public_Schools_point =l -
Highways_line
Interstates_line Outputlayer: -
Streets_line Frn 1 E Import Settings...
Land_area
Parks_area Style: [Custom] - |l Export Settings...
Rules: [custom] s
Suppression layer: -

Label filters:

L4

10 | MAPublisher 9.1 LabelPro Tutorial
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4. The first layer in the Source list, MAP_TITLE, will be designated as an obstacle. Click the corresponding spot in

5. Now designate the other layers as labeled or an obstacle by clicking the appropriate column:

the Obstacle column.

Source

D &

4 0 San Francisco Downtown

MAP_TITLE el

Pl Post_Offices_point
| Public_Schools_point
Highways._line
Interstates_line

Parks_area

I

MAP_TITLE
1s obstacle
Is labeled
Label source: #FontFamily
Output layer: [T] HIGHWAY_INTERSTATE lat
Priority: 1
Style: [Default]
Rules: [Default]
Suppression layer: | [7] [Ignored]

Notice that the Is obstacle check box is also checked, indicating that it is designated as an obstacle.

Labeled
Public_Schools_point
Highways_line
Interstates_line
Streets_line
Land_area

Obstacle
Post_Offices_point
Public_Schools_point
Highways_line
Interstates_line
Parks_area

3.2 Labeling extents setup

Source Q

o

4 @ San Francisco Downtown
MAP_TITLE
7 Post_Offices_point
E| Public_Schools_point
Highways_line

D
%
Interstates_line 3
9
®

O O O o

Streets_line
[& Land _area
Parks_area

.

[}

e e e

Land_area
[ 1s obstade
Is labeled
Label source:
Output layer:
Priority:

Style:

Rules:

[5] AREA_NAME -
HIGHWAY_INTERSTATE lat +

1 =

[Defaul] -

The configuration described in this exercise will limit the creation of labels to the extent of the selected source
layers for labeling, with a margin of 0.2 inches on each side.

1. Click the Advanced button in the MAP LabelPro dialog box. =
2. Under Label Placement Area, choose the Extents of labeled e o
layers option. ©) Extents of absled layers
3. Click the Label Margins check box. Set the Top, Left, Right and Label Margins:
Bottom drop-down lists to 0.20in. Tp: 0200
Left: 0.20in
Note: If the option Paths without stroke are not considered obstacles fcht 0,20
is checked, areas that have no stroke will not be used as an Botien: |0.20
obstacle in the labeling process, allowing generated labels Obstacles:
to overlap with them. L

OK

Cancel

[T] Paths without stroke are not considered obstades

4. Make sure that the settings match the image above and click OK.

The label styles and rules of each source layer are now ready to be set.

MAPublisher 9.1 LabelPro Tutorial
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3.3 Point layer label settings
1. In the MAP LabelPro editor dialog box, click Public_Schools_point in the Source list to highlight the row.

By default, the attribute to use as a label is set to FACILITY_|, the first string attribute column of the
Public_Schools_point layer. It needs to be changed to SCHOOL_NAME.

Note: Increase the width of an attribute column to see its full name.

2. Click the Label source drop-down list and choose SCHOOL_NAME.
3. Click the Output layer drop-down list and choose SCHOOL_labels.

Source Q

i | [ Public_Schools_point

o

4 @ San Francisco Downtown
; Is obstade
MAP_TITLE & L
7| Post_Offices_point & Is labeled
7] Public_Schools_point ' < 1| (abel source: 5CHOOL_NAME -
Highways_line & & 1
Interstates line 5 & 1 |Outputlayer: SCHOOL _labels -
Streets_line ?® 1 | priority: 1 =
Land_area ® 1
Parks_area & Style: [Default] h
Rules: [Default] - £

Leave the Priority column set to 1. The Public_Schools_point layer will be labeled as a first priority while the
others will be set to a secondary priority. Next, you'll change the style and rules for this layer.

4. Click the Style drop-down list and choose School_Label_Style. Click the Edit button to open the Style dialog
box and examine its settings. This style was predefined for the purpose of the tutorial.

Style
Font family: [ I Verdana v] [ oK ]
Fontstyle: [Bold [ can
Size: 6.00pt =

:
coour: [
Opadty: ’j 100% =
[ Add halo to label
colour: ||
Size: | 1.00pt

Preview:

Note: The second labeling session will show how to create a new style from scratch.

5. After reviewing the point Style settings, click OK to close it.

12 | MAPublisher 9.1 LabelPro Tutorial
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6. Click the Rules drop-down list and choose School_Label_Rule. Click the Edit button [ .| to open the Point Rules

dialog box and examine its settings. These rules were predefined for the purpose of the tutorial.

Point Rules
Allow stacking  |Up to 4lines +
Clear Last New
:] _ Alignment: \é?m Cancel
Clear Al o Cliy
[ Allow labels to cross lines
3 2

Select pasitions in order of priority.

Unselected positions will not be tried.

[7] Allow use of leader lines
Allowed line crosses: |3
Leader width: Lo0pt

Arrow style: Style #1

Allow font reduction
Steps: 4 =

Each step allows LabelPro to shrink the
selected font by 0.5 pt i necessary

[Z] Allow overlapping labels

New,
Yo
oy

These point settings will force the labels to be placed below the symbols:
« When possible, the text will be placed lower-middle to the symbol.
« If this is not possible due to space constrictions, text will be placed to the lower-right, and then to the lower-left.
- If none of the options can be applied, the text will be placed on the suppression layer (or ignored if no

suppression layer was specified).

- Text stacking and font reduction have also been enabled to add flexibility to the placement rules.

Note:

7. After reviewing the Point Rules dialog box, click OK to close it.
8. Click the Suppression layer drop-down list and choose SUPPRESSED_labels.

« Setup Layers
Source ® &1
- 0 San Francisco Downtown
MAR_TITLE é
F| Post_Offices_point (’.
Tl Public_Schools_point 5 & 1
Highways._line ® & 1
terstates_line D & 1
treets_line % 1
and_area Q 1
Parks_area é
Label fiters:

F| Public_Schools_point
Is obstade
Is labeled

Label source: [ 5] scrooL_name -] [ Advanced... ]
oupie:
1 B
Style: [school_Label style ~ |[7][3] [Export etings...

Rules: School Label R = |[o7][]
Suppression layer: | [T] SUPPRESSED_labels -

To label this layer using multiple types of labels, cick T to

add a label filte; or §

to batch generate label filters,

MAPublisher 9.1 LabelPro Tutorial

3

Labeling Session #1

More information on the available labeling options can be found in the MAPublisher User Guide, chapter 17.

13



Labels that can not be placed will be copied to the SUPPRESSED_labels layer.

Note: Scroll to the right of the MAP LabelPro dialog box or expand it to see the Suppression Layer column.

This finalizes the configuration for the labeling of the Public_Schools_point layer. Do not close the MAP LabelPro
dialog box as the configuration of the roads and land layers still have to be set. If you want to save the current
configurations, click the Save button. You will have to reopen the MAP LabelPro dialog box to continue.

3.4 Line layers label settings

This section covers the labeling configuration for the source layers Highways_line, Interstates_line and Streets_line.
Highways and interstates will be labeled using highway and interstate symbol shields—notice that these layers
contain double-lines for each road (divided highways).

3.4.1 Label lines with symbols

In the MAP LabelPro dialog box, click the Highways_line layer name in the Source column to highlight the row.
Click the Label source drop-down list and choose HIGHWAY_NUMBER.

Keep the Output layer as the default (HIGHWAY _INTERSTATE_labels).

Set the Priority to 2.

Click the Style drop-down list and choose Highway_Label_Style. Click the Edit button [, | to open the Style dialog
box and examine its settings. This style was predefined.

A wN =

Style

Font famity: |  Verdana ok |
Fontstyle: [Regular ) [ cancal
Size: 10.00 pt ~
cdour: [ ]
e
Opacity: ’j 100% =
[ Add halo to label

colour: ||

Sze:  [Lo0pt

Label with symbol
Symbol file: | generic_shields.Isf -
Symbol: @ United States Interstate ¥ | Height:  18.00 px |+

Preview:

No preview available

Show actual size

In addition to the regular font settings, line labels can also be labeled with symbols. In this case, the Label with
symbol option is enabled. Symbol files (*.Isf) contain a series of symbols. In the example above, the United States
Interstate symbol is selected from the generic_shields.Isf symbol file. The symbol size is set to a height of 0.25
inches. The symbol font color is set to white so it can be legible against the blue symbol.

14 | MAPublisher 9.1 LabelPro Tutorial
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6. After reviewing the Style settings, click OK to close it.
7. Click the Rules drop-down list and choose Highway_Label_Rule. Click the Edit button [ .| to open the Line Rules
dialog box and examine its settings. These rules were predefined.

Line Rules
i i Nl cvertang: | 30,00
& Comner
- Save ds.
gzt = =
Offset
Be - | A bl 1o cross Ines p
Main Strdot |
| Lot s
o 2ot 7| Adow for reduction
e : A
atse Eoon
Label joined fea, —— e e P o
& |
Ao use of leader Ines.
= i e e
o P
> "
i
dow overiappng lsbels —E'.
Seread words, | K,
Spacng: | Lo Main st |

With these settings, the highway labels (and shields) will be placed in the middle of each line length and on the
centerline, with a font reduction (if necessary). The Divided Highways setting recognizes lines that are parallel
and share the same name (as specified by the selected attribute). In such cases, it places only one symbol
instead of two or more. The Allow labels to cross lines option needs to be enabled because double highway
lines are very close in proximity and the labels need to cross the lines. More information on line labeling rules
can be found in the MAPublisher 9.1 User Guide, chapter 17.

Note: Evaluation users will see a different result than a licensed user. Because of the text scrambling, the divided
highways cannot be recognized. Here is an example with the interstates:

Result with license: F‘{aegult with evaluation:

8. After reviewing the Line Rules settings, click OK to close it.
9. Click the Suppression layer drop-down list and choose SUPPRESSED_labels.

The settings for the Highways_line layer are completed. Continue with the settings for the Interstates_line layer.

MAPublisher 9.1 LabelPro Tutorial | 15
3 Labeling Session #1



10. Click the Interstates_line layer name in the Source column to highlight the row.
11. Click the Label source drop-down list and choose INTERSTATE_NUMBER.
12. Keep the destination text layer as the default (HIGHWAY_INTERSTATE_labels).

13. Set the Priority column to 2.

14. Click the Style drop-down list and choose Interstate_Label_Style. Click the Edit button .| to open the Style
dialog box and examine its settings. This style was predefined.

[7] Add halo to label

cour: [ ]

sze:  [100pt

[¥] Label with symbol
Symbol file: generic_shields.Isf -

Preview:

Sample text

Style
Font famiy: | W Verdana o ]
Fontstyle: [Regular *) [ cancal
Size: 10,00 pt =
coor: [

Opacity: ) 100mfz

3.4.2 Label lines with text only

The United States Route symbol is selected from the generic_
shields.Isf symbol file. The symbol size is set to a height of 0.25
inches.

15. After reviewing the Style settings, click OK to close it.

16. Click the Rules drop-down list and choose Interstate_Label _
Rule. Click the Edit button [ .| to open the Line Rules
dialog box and examine its settings. These rules were
predefined.

The labeling rules for the interstates are the same as for the
highways. Also, the previous note about text scrambling
applies for evaluation users.

17. After reviewing the Line Rules settings, click OK to close it.
18. Click the Suppression layer drop-down list and choose
SUPPRESSED _labels.

The label settings for the interstate roads are now complete.
Continue with setting up street labels.

1. Inthe MAP LabelPro dialog box, click the Streets_line layer name in the [sye

Source column to highlight the row. Keep STREETNAME as the Label . S

source attribute. Fontstye: (Bold ) [conee
2. Click the Output layer drop-down list and choose STREET_labels. seet  Gooot =
3. Set the Priority column to 2. wer [l

4. Click the Style drop-down list and choose Street_Label_Style. Click the || ===
Edit button [.._| to open the Style dialog box and examine its settings.

This style was predefined.

Notice that this time Label with symbol is not checked.

5. After reviewing the Style settings, click OK to close it.
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Opacity: 1 100

[ Add halo to label

calurs [ ]

Size:  |1.00pt

[] Label with symbol

Symbol file:

Symbol: Height:  [Aute

Preview:




6. Click the Rules drop-down list and choose e Rkt

Street_Label_Rule. Click the Edit button g B Mo et s o o] e ]
[.=_|to open the Line Rules dialog box $ i oy | ]
and examine its settings. These rules were e [ smesa. |
predefined. —

Like highway and interstate labels, street
labels will be placed in the middle of each
line length and on the centerline, with an

Alow labels to cross Ines

eventual font reduction if necessary. The & Centetne e (DR
ability to overhang is enabled here. Siepa: ; : AA ;
B Labl joined feature. E E’:‘J‘;:-g;:w;.ﬂ(mmu-mm A

The street lines in this file are not joined. P

For example, each street is made of many o SR e e
Figea —

line segments that all share the same " e vl -

STREETNAME attribute. To avoid repeating Repestisbets

jch.e ngrpe of conrllef:ting Ili)Tej, ;c\::;_al_bﬁl o PaO! B0 1 indes - ——— —

joined feature rule is enabled. abelPro i varie i

recognizes that connecting lines sharing a specru: (200 fof s~ e

same name need to be labeled only once.

Note: Evaluation users will see a different result than a licensed user due to the text scrambling. Names are not
recognized as being the same and labels will be created for each line segment rather than one per street.
Result with license: Result with evaluation:

RIS R
&/
.
%, f

&
& %
V4 t;? " %’%
© s
Py &
@ %‘qﬁ"

a5

7. After reviewing the Line Rules settings, click OK to close it.
8. Click the Suppression layer drop-down list and choose SUPPRESSED_labels.

This completes the label settings for all line layers. Do not close the MAP LabelPro dialog box as the configuration
of the Land_area layer still has to be done. If you want to save the current configurations, click the Save button. You
will have to reopen the MAP LabelPro dialog box to continue.
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3.5 Area layer label settings

This section covers the labeling configuration for the source layers Land_area. The goal is to add large labels for the
land areas of the map (downtown area, Treasure and Alcatraz Islands).

1. Inthe MAP LabelPro dialog box, click the Land_area layer name Style

in the Source column to highlight the row. Keep AREA_NAME as Fant faniy: [0 Avic Sl

the Source label attribute. Fontstyles [Regular ) [ cana
2. Click the Output layer drop-down list and choose LAND_labels. s moo =
3. Set the Priority column to 2. coour: [l
4. Click the Style drop-down list and choose Land_Label_Style. Click Label ase:

the Edit button [ .| to open the Style dialog box and examine Opadty: 0 wonf

its settings. This style was predefined. 00 Add hﬂ'ﬂmD'ﬂhE‘

Colour:

Size: 1.00 pt

Note: The sample text is cut off because the font size is set to 70 pt
and is larger than the preview area. Preview:

sample tex

5. After reviewing the Style settings, click OK to close it.

6. Click the Rules drop-down list and choose s
Land_Label_Rule. Click the Edit button [z | to S : : =
open the Area Rules dialog box and examine et — e[ Y=
its settings. These rules were predefined. I, — - |
by mabereed | R | 7)Ao bl o e os
Th . . 7] Aow cuteide - Lane% F‘.‘{
e main requirement for labels created _ e 0|
from the Land_area layer is that labels are e [ E——
placed in the water area. Therefore, the Allow T st . B AA
outside rule is the only placement option e b s [ ST | AR — LA
enabled. Stacking and font reduction option N £ T ;
are also enabled to give more flexibility to the = e RS =W
rule. More information on the available area L=
labeling rules can be found in the MAPublisher —

9.1 User Guide, chapter 17.

Note: Labeling Session #2 will explain the creation of area rules for the Parks_area layer.

7. After reviewing the Area Rules settings, click OK to close it.
8. Click the Suppression layer drop-down list and choose SUPPRESSED_labels.

All layers have been now configured for the first labeling session.
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3.6 Execute labeling with MAP LabelPro

1. Make sure that all the layers have been configured to match the image below and click the Label button.

MAP LabelPro

4 @ Snfancicobowmoun |

MAP_TITLE

&
¢

&
7! Post_Offices_point & [¥] 15 labeled
2| Public_Schoals_point > < 1| abel source: [IEAREA_NAME v] l Advanced... ]
Highways_line D & 2
Interstates line T & 2 | Ouputlayer LAND_labels =
[EJ streets line % 2| priority: HEE
[& Land_area ® 2
[& Parks_area & Style: [end Label style  ~ [7][5¢] [Export settings...|

Rules: Land_Lebel Rule  ~
Suppression layer: [ [T] SUPPRESSED_labels -

To label this layer using mutiple types of labels, click 16 to
add a label fites or 4 to batch generate labe fiters.

Label filters:

Note: For evaluation users only. Review the MAPublisher warning message and click OK to close it.

case, spacing & punctuation so that the results give a sense of how actual labels would

i ) The Evaluation version of Label Pro scrambles the text of placed labels but preserves the
be placed.

Please also note that Unicode & foreign glyphs are mapped on to standard Latin
characters when the labels are scrambled, but are fully supported in the licensed version

of LabelPro.

2. Wait for the process to end to visualize the results (see next page).

The map layers are labeled. Make the SUPPRESSED_labels layer visible to show labels that couldn't be placed
with the specified rules.

3. Save thefile and leave it open to continue on with the second labeling session.
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Result with full license:

Note: Evaluation users will observe scrambled labels on the map. The Label joined feature rule does not recognize
similar street names due to the text scrambling and places more labels than necessary. Similarly, highway
and interstate roads are labeled with two shields with different numbers. Licensed versions will not see any
text scrambling.

20 | MAPublisher 9.1 LabelPro Tutorial
3 Labeling Session #1



4 Labeling Session #2

In this second labeling session, continue with the San Francisco.ai file that you saved. This time, only the parks will
be labeled in a single labeling execution of MAP LabelPro. The objectives are to:
+  Create alabel filter to label small parks and large parks.
- Create new area label styles for small and large parks.
«  Create new area label rules for small and large parks.
« Make sure that the park labels do not overlap with the other labels and with the post office and school
symbols and do not cross highway and interstate lines.

To start MAP LabelPro, click the MAP LabelPro button on the MAPublisher Toolbar. The settings from the previous
labeling session are remembered. For the new session, the layer setup has to be changed to match the new
objective of this exercise. However, the label extents remain the same as before.

4.1 Layers and obstacles setup

1. Inthe MAP LabelPro dialog box, click the Setup Layers button to setup which layers are shown.
2. Inthe Setup Layers dialog box, click the top Show check box (level with San Francisco Downtown MAP View).
Click the check box again to uncheck all of the check boxes below. Check only the following layers:

Setup Layers

Name Show oK
4 @ San Francisco Downtown
m
«  HIGHWAY_INTERSTATE_labels Lo b e
. MAP_TITLE ]
SCHOOL_labels BAAK bl g
« STREET labels SCHOOL labels
> X STREET labels
. Post_Ofﬁces_pomt SUPPRESSED_labels B
- . P Post_Offices_point
«  Public_School_point 7] Public_Schosls_point
. . Highways_line
«  Highways_line Interstates line
. i Ramp_line ]
Interstates_line Eome e &
. Parks area background ]
- Land_area ]
Parks_area

3. Click OK to return to the MAP LabelPro dialog box.
4. Click the Labeled icon for the Parks_area layer only. Make sure the all remaining layers are set as obstacles:

Source ® &t Parks_area
- HIGHWAY_INTERSTATE_labels . @ s rncsce bomntonn
. [ 15 obstacle
. HIGHWAY _INTERSTA... <
SCHOOL_labels SCHOOL Jabels : Islabeled
»  STREET labels STRCCT lobel R
o 7| Post_Offi it =
+  Post_Offices_point © Pubic Schosls point &, | Otpetiaer
- Public_School_point D Highwoys fine & | pronty s
— — Interstates_line & _
. HighWGyS_line [& Parks_area M 1 | Style:
« Interstates_line Rules:
Suppression layer:

5. Make sure that the settings match the image above and click OK.
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4.2 Create Label filters

This section covers the labeling configuration for the source layer Parks_area. The goal is to add labels for small parks
and large parks (based on the #Area attribute). This is done by creating Label filters that can isloate and classify data
using expressions. In addition, styles and rules will be created from scratch.

22

In the MAP LabelPro dialog box, click the Parks_area layer name in the Source column to highlight the row.
Below the Source list, click the Batch generate label filters button.

In the Batch Label Filter Generator dialog box, click the Attribute drop-down list and choose #Area, then click the
Load button.

In the Data Classification section, click the Method drop-down list and choose Natural Breaks (Jenks-Capsall) and
change the Data classes to 2.

Batch Label Filter Generator

Source: [ Parks area [F tgrore: A
Attribute: #An -
bu [ [B] #Area ] Empty expression. In position: 0
Load
Data Classification:

Source: 44 value(s) (44 unique) from #Area
Method: |Natural Breaks (Jenks-Caspal) = | Datadasses: 2 |3 Indusive boundary: |Start value -

Expression Start End

1 2,062342510951682925 <= #Area < 150,047 609731424539886 2,062.342510951682925  150,047.609731424539886

2 150,047 509731424599886 <= #Area <= 500,626.657021895051003 150,047.609731424599886 500,626.657021895051003

[ Add rule expressions to Recent Expressions in Expression Library Add rule for ignored expression

Two classes (defined by two generated expressions) will define the small and large parks. The Natural Breaks
classification looks for appropriate breaks in the data where to use as data class boundaries. The next step is to
set some default settings for the labels (which sets them for both label filters).

In the Default Settings section, click the Is labeled check box. Click the Label source drop-down list and choose
PARK_NAME. Click the Output layer drop-down list and choose PARK_labels from the drop-down list. Click the
Suppression layer drop-down list and choose SUPPRESSED _labels.

Default Settings:

[ 1s obstade Priority: 1 =

Iz labeled Style: [Defaug &7
Label source: [ PARK_NAME v] Rule: [ Defaurg v]
Outputlayer: | ] PARK Jabels ~|  Suppressionlayer: | [T] SUPPRESSED labels -

Click the Add button to add the two label filters.
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4.3 Create styles and rules

1. Inthe MAP LabelPro dialog box, click the first label filter for the Parks_area layer to highlight it. Change the
name of the first label filter to Small Park.

Source &

4 | Name:  Small Park

o

4 @ San Francisco Downtown [ 1= abstzce
HIGHWAY_INTERSTA. . é
SCHOOL labels & EEEE
STREE ol L | tedonre
7] Post_Offices_point &
7] Public_Schools_point & Output layer:
Highways_line & Priority: 1
Interstates_line &

4 [A Parks_area 2 Style: [Default] - ¢
T Small Park 2 1
Rules: [Default] - 3
T 15004761 <= 2. > 1
Suppression layer: SUPPRESSED_labels -
Label Filter:
() Apply to all
@) Limit by expression:
#Area >= 2062.342511 AND #Area < 1 ]

" The expression is valid.

Stop if art satisfies this expression

2. Beside the Style drop-down list, click the Edit button [.."| to open the Style dialog box.

3. Make sure that Arial is selected in the Font family drop-down list and that Regular is selected as the Font style.
4. In the Size drop-down list, set the font size to 7.00 pt

5. Click the color chip and in the Color Picker dialog box, pick dark green color (e.g. R=0, G=85, B=0) and click OK.

ESE S

I @H 120 *
@5 100 %
@B 33 %

D.d ©R: 0 Gl 85

©G 8 M 40

©B: 0 Y. 100

. # 005500 K 40

[T Only Web Colars

6. Click the Save As button. In the Save As dialog box, type Small_Park_Style in the Name box and click Save.

Save As

MName: Small_Park_Style v

7. In the Style dialog box, click OK.
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In the MAP LabelPro dialog box, the Style drop-down list now displays Small_Park_Style. The style is saved in the
directory specified in the MAPublisher Preferences.

11 Interstates_ine ©
4 [ Parks_area 2N Style: small Park Style v [o7)[3] [BxwortSettings...
T Small Park % 1
Rules: [Defauit] - 4
T 15004761 <= £.. & 1
Suppression layer: SUPPRESSED _labels -

Next, you'll create the rules for the Small Park label filter.

8. Beside the Rules drop-down list, click the Edit button to open the Area Rules dialog box.

9. Inthe Area Rules dialog box, under Placement, click the Allow extending beyond boundary check box.

10. Click the Allow use of leader lines check box and keep its default parameters.

11. For the Allow stacking rule, choose Up to 4 lines from the drop-down list. Leave the alignment as Feature.
12. Click the check box for Allow labels to cross lines to disable the rule.

Area Rules
Plocement — B 7 [ .C-K“
stackrg [Up o 4ines = |
FITR—— iy Park Moment:  [feanee»|| Sa0 Smead
o domnant angle Ty P~ | Savess
Al extendng bevond . [~ |
v : Mwelﬂ?ltk| Ao labele 10 croes ines =
Aoy putside. | Sl L }P‘g
Mhow ingde, song
boundary
] Alow font reducon
¥ Alow s of leader Ines - . : AA
Yorwr Each mep alows LabePre w sherk the | A
Alowed ine creases: 3 selnoned fomu iy 0.5 pu F mecesary
Lesder width: Lo0p LS
Alere rervlegars bty
Ao sty Stle el
o

13. Click the Save As button and in the Save As dialog box, type Small_Park_Rules in the Name box and click Save.

Save As

MName:  Small_Park_Rules -

14. In the Area Rules dialog box, click OK.

In the MAP LabelPro dialog box, the Rules drop-down list now displays Small_Park_Rules. The rule is saved in the
directory specified in the MAPublisher Preferences.

15. Repeat the same process to setup the second label filter as Large Park. Choose a different font style and label
color to help distinguish large parks from small parks.

Hint: Choose the same Style and Rules as Small Park label filter. However, edit the Small_Park_Style to change the
font style and label color, then save it as Large_Park_Style.
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MAP LabelPro

E] Source ® & Name: Large Park m
4 @ San Francisco Downtown [ 15 obstade E

¢
=

£ [ Cencd |
AGHWAY INTERSTA... &
CHOOL labels & Iz labeled
STREET labels u Label source: [ 51 Park_rame - [ Advanced... ]
7| Post Offices point &
7] Public_Schools_point &  |Outputioyer: [T RARK Ehels b
Interstates_line é
4 [E Parks_area Y Style: [Lorge_Park Styie = |[o7][%] [Bxport setings...|
T Small Park [ 1
Rules: Small Park Rules =
T Large Park Y 1

Suppression layer: SUPPRESSED _labels -
Label Filter:
© Apply to 2l
@ Limit by expression:
*Area >= 150047.609731 AND #Area « D

' The expression is valid.

Stop if art satisfies this expression

Label filters: @

4.4 Execute labeling with MAP LabelPro

1. Make sure that all the layers have been configured appropriately and click the Label button.

The parks are labeled appropriately according to the style and rules defined in MAP LabelPro.

2. Click the MAPublisher Log button on the MAPublisher Toolbar.

MAPublisher Log

When Layer Message Clear
4Masecondsago | LabelPro labeling session

» 51 seconds ago . Messages during label generation Deselect All
ﬁ TOTAL: 43 label(s) were placed -

B

6 TOTAL: 1 label(s) could not be placed Export
> 22 hours age @ LabelPro labeling session
> 1dayago ¥ LabelPro labeling session
1 day ago % Document Load

show: (@] [

Statistics about how many labels were placed (or not placed) on each layer are displayed in the log. Notice that
the first labeling session is also listed.

3. After reviewing the statistics, close the MAPublisher Log dialog box.
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Congratulations, you have completed the MAPublisher 9.1 MAP LabelPro tutorial. For more in-depth information
on MAPublisher tools and features, please take a look at the MAPublisher 9.1 User Guide , MAPublisher 9.1 Tutorial
Guide and Quick Start Guide. These documents are installed with MAPublisher or can be downloaded from
http://www.avenza.com/documentation.
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